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Introduction  
These notes are designed to cover the essential features of Microsoft Word. It covers everything 
which all users should know, whether they are complete beginners or are already reasonably 
familiar with Word. Once you have made sure you know the fundamentals, take a look at the 
intermediate level guide, Microsoft Word 2007: An Intermediate Guide. 

Logging on to an IT Services Managed Computer 
If you are using an IT Services PC running Windows XP, you will first need to start up the computer. Even if the 
screen is black, the computer should be running.  

1. Press any key to activate the computer  

2. If the screen still remains black, check the last user hasn't turned off the monitor or PC  

3. Next press <Ctrl Alt Delete> - ie hold down both the <Ctrl> and <Alt> keys and press <Delete> 

You should now be able to login: 

4. Enter your username and password into the boxes on the screen (the <Tab> key -  the key immediately 

above <Caps Lock> on the far left of the keyboard – can be used to move between the boxes) 

5. Press <Enter> or click on [OK] 

Using the Mouse, Keyboard and Windows 
The mouse has two buttons separated by a central scrolling wheel. Throughout this course, always press the 
left mouse button when told to click on a tab or command button (unless explicitly told to right click, in which 
case press the right mouse button). 

If you haven't used a keyboard before you may think the order of keys is confusing. Don't worry about this - 
you soon get used to it. It is in fact designed for touch typing (using all fingers), with the most frequently-used 
keys in convenient positions. If you need an introduction to the keyboard or would like to learn how to type 
properly, go to Accu-Type training under Teach Yourself via the Start menu and All Programs. For further 
details see the  Using the Keyboard Quick Guide. 

To get CAPITAL LETTERS you can use the <Caps Lock> key but this is only really used for typing everything in 
upper case. If you require just a single letter (or a character above the numbers on the top row) then hold 
down the <Shift> key (immediately above <Ctrl> on both the left and right) as you press the relevant key. 

If you are not familiar with the Microsoft Windows XP then have a look at the Microsoft Windows XP  Beginners’ 
Guide. 

Starting Microsoft Word 
To load Microsoft Word: 

1. Click on the Start menu in the bottom left corner of the screen 

2. Choose All Programs then Microsoft Office (from the sub-menu which appears) 

3. Finally click on Microsoft Office Word 2007 

Tip: You'll probably be using Word quite frequently in the future, so it's worth putting it as an icon on the 
Desktop. To do this, repeat the above steps, but at the last step, right click (ie press the right mouse button) 
and choose Send To followed by Desktop (create shortcut). To load Word in future, simply double click on 
the Desktop icon.  

http://www.reading.ac.uk/web/files/its/WordInter.pdf
http://www.reading.ac.uk/web/files/its/keyboard.pdf
WindowsXP2.pdf
WindowsXP2.pdf
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The window shown below will open, ready for you to begin typing. 

 

Office Button  

In the top left-hand corner is the [Office] button which can be used to open and print your document. To 
the right of this is the Quick Access Toolbar which contains icons to a few commands, eg save and undo, and 
to which you can add further buttons. Below this is the Ribbon, with tabs along the top and command 
buttons on each tab. These can be used to give instructions to Word.  

Scroll bars are provided on the right (and bottom) to let you move up and down (or sideways across) your 
work. At the very bottom of the window, there is information about where you are in your document on the 
Status Bar - here you are on Page 1. The information that is shown on the Status Bar is a word count and the 
language you’re working in. On the right-hand side of the Status Bar are icons to change the view of the page, 
and to zoom in or out, ie make the text on the screen bigger or smaller. 

Writing Your Document 
You next need to decide how you want the rest of your text to appear. It's easiest to set this up before you 
start typing - the settings will then be carried forward from one paragraph to the next.  

Changing Fonts 

Font -  

The starting font for a new document in Word 2007 is usually set to Calibri (Body). You might want to use a 
different style of lettering (font or typeface) to personalise your work. Several fonts are available in Word. If 
you want to change the current font: 

1. Click on the list arrow attached to the [Font] button on the Home tab 

2. Click on the font you require, eg Times New Roman – you can either scroll down the list to find the font 

you want, or type in the name of the font to pick it up more quickly 

Tip: It's best to stick to true-type fonts (those labelled TT) to maintain your document's portability.  

Some fonts (eg Symbol and Wingdings) produce non-Roman letters or iconic symbols. Courier New gives a 
typewriter font. Sans-serif fonts, such as Ariel, give clear headings. 
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Changing Font Size 

Font Size -  

Generally a point size of 10, 11 or 12 is used for the body of the text while point sizes of 13 to 16 are used for 
headings. The current size (11) is shown in the font size box. To alter this:  

1. Click on the list arrow attached to the [Font Size] button on the Home tab  

2. Click on the size you require - for example, 12 

Tip: You can also type the number directly into the font size box (press <Enter> to set it). This allows you to 
select a font size not in the list, for example 13 or a bigger number if you want very large characters.  

Entering Your Text 
1. Type in a few words, pressing the <spacebar> once after each word to separate them (the spacebar is 

the long key along the bottom of the keyboard) 

If you are not very fast at typing just type some imaginary words, pressing keys at random, but remember to 
include spaces between your words. Remember that if you want to improve your typing, there is an Accu-
Type training tutorial on the IT Services PCs (you can also buy a copy for a personal computer). 

2. Continue typing across the screen - the words will automatically spill onto a new line when you reach 
the right-hand side (this is known as wraparound) 

3. Continue typing until you have at least three lines of words then press <Enter> to mark the end of the 
paragraph (this is the upside-down L-shaped key on the right of the main keyboard – it is also located 

on the far right of the keyboard, in the numeric keypad, with the word Enter written on it)  

IMPORTANT: When using a word processor, do NOT press the <Enter> key at the end of each line. If you 
need your work double spaced (each line followed by a blank line) then you simply change the paragraph's line 
spacing - this is covered later on. Press <Enter> only when you want to start a new paragraph. 

A jagged red (or occasionally green) line may appear beneath your text. Don't worry about this - Word is 
telling you that what you typed is not recognised (the words are not in the dictionary) or that the grammar 
may be incorrect. You learn more about this later. 

Tip: Never press the <spacebar> or <Enter> key more than twice in succession. In particular, do not use 
spaces to centre a heading or line up words in columns, or to add extra blank lines to force a heading onto a 
new page. There are special key presses that do this for you (tabs and hard page breaks) that are covered in 
our Microsoft Word Intermediate Guide.  

4. Practice typing a couple of extra paragraphs, pressing <Enter> at the end of each 

Correcting Mistakes 
Don't worry if you go wrong, as it is very easy to correct your work. The <Backspace> key (immediately 
above <Enter> in the main section of the keyboard) can be used to delete the last character(s) typed.  

1. Press <Backspace> a few times and note what happens 

You should have noticed a flashing vertical bar on the screen at the end of your work. This marks the insertion 
point. Anything that you type will always appear at the insertion point. You can move the insertion point 
around your work by using the arrow keys to the right of the main keyboard. You can also change its position 
by moving the mouse pointer on the screen and clicking where you want the insertion point to be.  

2. Press the <arrow> keys to move the insertion point around - note that you can hold down a key to 

move more rapidly 

3. Move the mouse to position the pointer in the middle of a paragraph and click on the mouse button - 

the insertion point should have moved to where you clicked 

http://www.reading.ac.uk/web/files/its/WordInter.pdf
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4. Type in some more words - watch how the text which follows moves sideways to make room for the 

new words 

As the text moves, the following lines of the paragraph are redrawn automatically. Within a paragraph, the 
<Backspace> key works as before but you can also remove characters forwards: 

5. Press the <Delete> key (immediately to the right of <Enter>) a few times and note what happens 

Here you are only practicing on text you do not need to keep, but you may accidentally delete words that you 
needed. Do not panic! If you ever make a mistake when using Word then you can undo your error by using 
the [Undo] button. 

Undo -  

This can be found on the Quick Access Bar in the top left-hand corner. The undo button can be used more 
than once, to undo a series of actions, one at a time.  

6. Click on the [Undo] button several times to see its effect 

Note: There's also a [Redo] button (to the right of [Undo]) if you accidentally undo too much! 

Tip: Word lets you use control key combinations to issue commands from the keyboard. The combination 
<Ctrl z>(hold down <Ctrl> and press <z>) can be used to undo something. <Ctrl y> can be used for redo. 

Aligning Text on the Page 

Align Left -    Centre -    Align Right -    Justify -  

With Microsoft Word, it's easy to change the appearance of your work. Changes to the way a paragraph is laid 
out can be made by first moving the insertion point into that paragraph (anywhere will do). You can then 
decide how you want your paragraph to look. 

1. Move the insertion point into the paragraph you want to change 

When typing a document you normally want text to align on the left-hand side of the page. Some people 
prefer text to be fully justified - this is where text aligns both left and right. You can also align text to the right 
(eg for an address) or to the centre (eg for a title or heading). You can use the buttons shown above (they are 
on the Home tab in the Paragraph group) to control how text is aligned on the page.  

2. Try out all four justification buttons (or use <Ctrl l>, <Ctrl e>, <Ctrl r> and <Ctrl j>) - note that only 

the current paragraph is affected; each paragraph has its own justification setting 

Tip: If you like justified text, consider turning on hyphenation. This automatically splits a long word at the end 
of a line in two, improving the layout considerably. To turn this on, click the Page Layout tab, then the 
[Hyphenation] button in the Page Setup group and choose Automatic. 

Altering Line Spacing 

Line Spacing -  

Sometimes you might be asked to double space your work (or use some other spacing). You might even 
choose to have a quotation (for example) one-and-a-half spaced, with the rest of your text double spaced. You 
should still be in the paragraph where you tested the different justification settings. 

1. Click on the list arrow attached to the [Line Spacing] button in the Paragraph group 

2. Select 2.0 for double spacing 

Tip: You can also use <Ctrl 2> (hold down <Ctrl> and press <2>) for double, <Ctrl 1> for single and <Ctrl 
5> for one-and-a-half spacing. <Ctrl 0> adds a blank line before a paragraph.  



Click here to download full PDF material

https://www.computer-pdf.com/office/word/4-tutorial-microsoft-word-2007-level-1.html

